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1 INTRODUCTION 

1.1 Product Overview 

Perception is a software product designed to assist power plant personnel in the 

maintenance and management of oil-insulated equipment used in the transmission and 

distribution of electrical power. It is used primarily for diagnosing fault conditions as well 

as trending measurements taken from transformers, circuit breakers and tap-changers. 

Perception Server is designed for fleet-wide monitoring and provides time saving 

scheduled downloading to automatically collect measurement data from devices, and 

then store it in a central database for simultaneous user access. The centralized location 

increases data integrity by creating a single point for data backup. OPC UA architecture 

provides secure network communication between client and server. Access control 

prevents unauthorized access to monitoring devices, limiting unit and configuration 

setting changes to designated personnel. 

If a discrete, ratio or rate of change alarm is triggered on the device, Perception Server 

will automatically send an email alert to notify the user of the change. The email 

notification system provides details on the current asset state, including gas levels and 

historical measurements. When exceeded, caution and alarm limits are highlighted, 

using a predefined colour-coding system. Email alerts can be configured at a unit level for 

critical transformers. Perception also has the capability to generate more detailed e-

mails on the overall transformer state via the Expert analysis e-mail feature. 

Although Perception is an expert analysis and information system, it is only an aid and 

should not be regarded as a replacement for the knowledge of someone who is an expert 

in the analysis of insulating oil used in electrical equipment and the operation of oil filled 

power equipment. 

1.2 Software Family 

There are four members of the Perception family. 

▪ Perception Desktop — A standalone software application that provides customized 
access to the centrally located asset database. It provides advanced diagnostic 
profiles on device data, a multi-page transformer report containing key transformer 
information as well as the facility to launch external applications. Additionally, 
Perception Desktop can operate standalone or as part of a larger centralized asset 
management suite in conjunction with Perception Server. 

▪ Perception Server — The pinnacle of transformer asset management software. 
Perception Server provides a fleet-wide network overview via a wallboard display, 
automatic data downloading with configurable scheduling, email notifications of 
device condition changes and a TOA4 data export facility. It uses a centralized data 
storage location based on SQL Server to which Perception Desktop links seamlessly 
via secure OPC UA communications. 

▪ Perception Web — A web-based solution that provides read-only access to the 
centrally located asset database. This offers a convenient way to obtain readings and 
consolidated data analysis across a variety of platforms including mobile devices. This 
includes transformer dashboards, wallboards and an overview to the status of the 
entire transformer fleet. 
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▪ Perception Workflow Designer — The workflow designer uses common flowcharting 
techniques to express transformer diagnostic processes as a model. These models 
are known as workflows and in turn drive the Perception dashboard. The Designer 
brings easily modifiable workflow-enabled capabilities to the Perception software 
suite allowing control over the diagnostic process and customization of how data is 
presented on the Perception dashboard. 

1.3 What’s New? 

▪ Perception Server database schema updated. The new schema number is 22441. 
Databases created before this release must be updated using the 
Perception.Database.Upgrade.Tool.exe. Note: If you are unfamiliar with the database 
upgrade process, contact GE M&D support. 

▪ Perception applications are supported in Windows 7, Windows 8, Windows 8.1, 
Windows 10, Windows Server 2003, Windows Server 2008, Windows Server 2012, 
Windows Server 2016, Windows Server 2019, SQL Server 2008 R2, SQL Server 2012, 
SQL Server 2014, SQL Server 2016, SQL Server 2017 and SQL Server 2019. 

▪ DGA 900 Plus with Bushing Monitoring – addition of 9 bushing functionality 

▪ DGA 900 Rate Of Change worksheet 

▪ DGA 900 Plus with Models OLTC Tap Position 

▪ Support for 8 series relays (845, 850, & 869). New installer, ranking workflows and 
diagnostic tools including COMTRADE download 

▪ DGA 900 MultiTank products, MultiTrans and TapTrans 

▪ New Motor asset and corresponding Dashboard 

▪ Lots of minor enhancements and bug fixes 

Note: If upgrading to Perception Desktop/Server 2.4. X from version 1.X, please 
contact GE Support before commencing as depending upon the size and 
complexity of the existing database, a service visit may be required to make the 
transition. 
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1.4 Server Features 

Perception Server offers the following: 

▪ Automatic scheduled results downloading 

▪ Wallboard facility gives an overview to the entire fleet 

▪ Facilitates transformer risk evaluation, fleet ranking and transformer and fleet 
dashboards 

▪ Centralised data source allowing multiple Perception Desktop instances to connect, 
gather and manipulate the same data 

▪ E-Mail condition notifications when devices raise condition alerts, communication 
issues, service or rate of change alarms 

▪ SQL Server database storage 

▪ Access control security with login permission level access settings 

▪ OPC UA Server 

▪ Ability to define a custom CSV file format for import and export, including out-of-the-
box support for Perception, TOA4 and TransConnect CSV formats 

1.5 Architecture 

The Perception Server architecture consists of one or more client PCs running 

Perception Desktop and a remote server machine running the Perception Server 

software as illustrated in Figure 1-1. 

Perception Server utilises OPC UA Discovery Server to establish a secure encrypted 

connection to a centralised repository for multiple Perception Desktop clients. This 

combination allows users to add DGA devices (and other GE transformer monitoring 

devices) and download the same devices and data. Perception Server uses SQL server to 

host the database. SQL Server can be hosted on the same server machine as Perception 

Server or on a separate dedicated server machine. 
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Figure 1-1: System architecture 

1.6 System Requirements 

Prior to installing Perception Server, ensure that the SQL Server bit type matches the 

operating system bit type. A 64-bit Windows operating system requires a 64-bit SQL 

application. Perception Server must be installed with an appropriate database 

connection and then the server license must be activated to avail of full functionality 

(refer to Section 2). 

The minimum PC and system requirements for Perception Server are: 

Operating System: Windows Server 2008 with .NET Framework 3.5 sp1, 4.0 & 4.5 

Database: SQL Server or SQL Express 2008 R2 

CPU: 3 GHz 32-bit (x86) or 64-bt (x64) processor 

Memory: 4 GB RAM 

HDD: 500 GB free 

Note: Perception Server requires FILESTREAM to be enabled on the Microsoft SQL 
Server instance. This can be done during the install of Microsoft SQL Server or 
retrospectively using the Microsoft SQL Server Configuration Manager. Ensure 
that the correct bit version of Microsoft SQL Server is installed to match the bit 
version of the operating system, e.g. 64-bit Microsoft Windows 10 must have 
64-bit Microsoft SQL Server installed. If there is a mismatch in bit versions 
FILESTREAM will not work. Visit  
https://msdn.microsoft.com/en-us/library/cc645923.aspx for more details. 

https://msdn.microsoft.com/en-us/library/cc645923.aspx
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Note: Windows Server 2012 does not enable Microsoft .NET 3.5 features by default. 
However, all Perception installers require .NET 3.5. 

Note: It is possible to exceed the SQL Express database size limit of 10 GB so 
upgrading to SQL Server is recommended if there are many monitoring devices 
and/or large data imports expected. 
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1.7 Software Licensing 

Perception Desktop uses a tier-licensing model when used with Perception Server. This 

provides greater flexibility to add devices and manage license expiry. There are six tiers 

in the model, as listed in Table 1-1, with each tier supporting an increasing number of 

devices according to a range of accumulated device weightings. 

Table 1-1: Tier scores 

Tier Accumulated 
weightings 

1 0-50 

2 51-100 

3 101-150 

4 151-250 

5 251-500 

6 501+ 

The weighting scores for each type of device are listed in Table 1-2. 

Table 1-2: Device scores 

Device Weighting Score 

Offline 1 

201Ti 2 

Hydran M2 / M2-X 3 

8 series relays 3 

MO150 4 

MiniTrans 4 

CB Watch3 4 

Transfix 5 

DGA 500 5 

DGA 900 5 

BMT 300 5 

DualTrans 6 

TapTrans / DGA 900 TapTrans 6 

MultiTrans / DGA 900 MultiTrans 6 

Transfix Plus 6 

DGA 900 Plus 6 

TMS 7 

MS 3000 7 

You can add any number of devices and assets within the limits set by the Perception 

fleet license tier. To add further devices or assets requires a license upgrade — contact 

Customer Support. 

Note: Customers on an existing annual fleet licensing agreement can add assets and 
devices beyond the limits set by the new license tier. However, once the annual 
fleet license agreement expires, the license tier is recalculated and may require 
an upgrade to service all devices. 

Note: When connected to Perception Server, the Fleet Summary window becomes 
available in Perception Desktop and provides details on the Perception license 
tier including expiry date and a summary of the devices and assets that have 
been added to the database. 
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1.7.1 License Expiry 

A License Expiry message appears in Perception Desktop 90 days before the Perception 

fleet license is due to expire as shown in Figure 1-2. Reminder messages are 

automatically scheduled to reappear at 60 days, 30 days, 15 days and 5 days, or on each 

first launch of the application within the set days of the expiration period. 

Note: This reminder applies to annual license agreements only. 

 
Figure 1-2: License expiry notification 

A yellow warning icon also appears in the lower right corner of the application window 

with a tooltip when you rest the mouse pointer over it as shown in Figure 1-3. 

 
Figure 1-3: License warning indicator 

Perception Server restricts functionality after license expiration. The following features 

are disabled: 

▪ Transformer Risk Evaluations 

▪ Fleet Ranking 

▪ Transformer and Fleet Dashboard 

▪ Wallboard Fleet Visualisation 

▪ Perception Web 

▪ Expert Email Notifications 

2.4 



MA-021 – Perception Server 2.4 – Installation & User Guide – Rev 10.0 6-Jun-23 Page 12 of 54 

1.7.2 Fleet Summary 

Perception provides a useful summary dialog with license tier details and all assets and 

devices that comprise the Perception Fleet. Select Help > Fleet Summary as shown in 

Figure 1-4. 

 
Figure 1-4: Help menu 

The Fleet Summary dialog displays as shown in Figure 1-5. 

 
Figure 1-5: Fleet Summary dialog 

1.8 Customer Support 

E-mail: GA.support@ge.com 

United Kingdom +44 1785-250-070 

North America toll-free: 1-800-361-3652 

Worldwide: +1 514-420-7460 

mailto:GA.support@ge.com
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2 INSTALLATION 

2.1 Overview 

The Perception Server Installer installs Perception Server and the Perception Server 

Configuration Tool. If the UA Local Discovery Server service is also installed, it is bound to 

the Perception Server, so restarting the UA Local Discovery Server also restarts the 

Perception Server. The Perception Server and Desktop are supplied on separate 

installation CDs. 

2.2 Run the Perception Server installer 

To install Perception Server, insert the Perception Server CD into the CD drive and 

double click the Perception.Server.Setup.exe file in the root directory of the CD. The 

Setup Wizard opens as shown in Figure 2-1. Click Next to proceed to the License 

Agreement. 

 
Figure 2-1: Welcome to the Perception Server Setup Wizard 
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If the License Agreement is acceptable, select I accept the terms in the License 

Agreement and click Next as shown in Figure 2-2. 

 
Figure 2-2: License Agreement 

Browse to select the installation folder or accept the default folder and click Next to 

continue as shown in Figure 2-3. 

Note: If the PC is shared with other users, you can choose to install Perception Server 
for use under the current login account only, or for all user accounts on the PC. 

 
Figure 2-3: Select Installation Folder 
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Click Next to start the installation, Back to backtrack and change some of the 

selections, or Cancel to quit the process entirely, as shown in Figure 2-4. 

 
Figure 2-4: Confirm Installation 
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Click Next and a progress bar indicates the progress as shown in Figure 2-5. The 

installation may take some minutes. 

 
Figure 2-5: Installing Perception Server 

The Setup Wizard completes the installation and presents the following message as 

shown in Figure 2-6. Click Finish to exit. 

 
Figure 2-6: Installation Complete 
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To install the TransCom software for TRANSFIX 1.0/1.5 device support, select the 

TransCom option and click Install Now. 

2.3 Create the Perception Server database 

Perception Server uses SQL server to host the Perception Server database. 

Note: SQL Server can be hosted on the same server as the Perception Server or on a 
separate dedicated server machine. 

To create the Perception Server database: 

▪ Open SQL Server Management Studio. 

▪ Log in using an Administrator account as shown in Figure 2-7. 

 
Figure 2-7: SQL Server login 

▪ Run the CreateSQLServer2005Schema.sql file in the Perception Server 

installation folder. Typically found in C:\Program Files\GE 

Energy\Perception\SQL Schema. 

▪ To apply the changes made by the schema, including manual database changes to the 
Perception Server, restart the Perception Server service. 

By default, a database called ‘Kelman’ is created in the SQL database list — this database 

is used by Perception Server to host the data. 

A specified SQL user account must be configured with ‘db_owner’ rights to the specified 

database. These account details are added using the Perception Server Configuration 

Tool to establish a connection between Perception Server and SQL. See Section 2.5 

Connect Perception Server to the database. 
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Note: SQL Server 2012 and 2014 do not give ‘NT AUTHORITY\SYSTEM’ ‘sysadmin’ 
permissions by default — users should assign this permission manually in SQL 
Management Studio - Logins. 

2.4 Enable MS-DTC Service 

To communicate with the SQL Server databases, the MS-DTC service must be enabled on 

the Perception Server. 

Select Start > Run, type services.msc and click OK. 

In the Services window, select the Distributed Transaction Coordinator service and 

click the Start Service button as shown in Figure 2-8. 

Note: To ensure that the service always runs if the PC restarts, right click on the 
service and select Properties. Set the Startup type to Automatic and click 
OK. 

 
Figure 2-8: Services - Select the Distributed Transaction Coordinator Service 
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2.5 Connect Perception Server to the database 

Open the Perception Server Configuration Tool and select the Database tab as shown in 

Figure 2-9. Note: All other tabs are disabled if the database is yet to be configured. 

  
Figure 2-9: Perception Server Configuration Tool – Database tab 

The recommendation is to use ‘Integrated Security’ (Windows Authentication) to 

connect to the Perception Database, since Perception Server uses ‘FILESTREAM’ which 

does not support SQL Authentication. 

Currently Integrated Security doesn’t support Active Directory so this requires that you 

manually create the same Windows user on the SQL Server machine to match the 

credentials of the user on the Perception Server machine. 

The Disable device data download checkbox disables data download from the device. 

This prevents measurement data from being downloaded each time the unit connects 

with Perception, but still allows Perception to poll for the service information from the 
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device and receive operational status information. This is useful in organisations where 

other applications, such as data historians are used to store measurements, as it 

prevents the storage of duplicate measurement data. 

Note: If Perception Server is installed on a different machine to the database, ensure 
that the account used to run Perception Server has access rights for 
FILESTREAM access on the Microsoft SQL Server instance. (Perception Server 
logs this fact in the Server.log file). 

2.5.1 User Access 

Select the security connection method defined by your System Administrator. An 

‘Integrated Security’ connection uses the profile of the currently logged-in user. 

If your MS SQL setup requires login credentials for access control, uncheck ‘Integrated 

Security’ and enter the user ID and password of the SQL user who has permission to 

access the Kelman database. The MS SQL login used must have the “db_owner” 

membership role for the Kelman database. 

2.5.2 Server Location 

Enter your SQL Server instance information into the Db Instance box. Typically, this is 

the computer name of the SQL Server host and the SQL Server instance name (i.e. 

SQLServerHost\SQLExpress). Finally, type Kelman into the Database box and 

click Save. 
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2.6 Activate the Perception Server 

Before the Perception Server Service can be started, the Perception Server must be 

activated with a license key. Open the Perception Server Configuration Tool and select 

the Activation tab as shown in Figure 2-10. 

 
Figure 2-10: Activate the Perception Server 

Then click the Activate button to open the license key activation wizard and follow the 

onscreen instructions (see Section 2.8). 
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2.7 Reactivate the Perception Server 

If the Perception Server needs to be reactivated (i.e. if the device limit has been 

changed), open the Perception Server Configuration Tool and select the Activation tab 

as shown in Figure 2-11 below. 

 
Figure 2-11: Reactivate the Perception Server 

Then click the Reactivate button to open the license key activation wizard and follow 

the onscreen instructions (see Section 2.8). 



MA-021 – Perception Server 2.4 – Installation & User Guide – Rev 10.0 6-Jun-23 Page 23 of 54 

2.8 Perception Server Software Activation Wizard 

The Activation Wizard is shown in Figure 2-12. Click Next to proceed. 

 
Figure 2-12: Welcome to the activation wizard 

Enter the license key provided with the Perception Server software and click Next as 

shown in Figure 2-13. 

 
Figure 2-13: License key activation 
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Select the Activation Method either Automatic (see Section 2.8.1) or Manual (see 

Section 2.8.2) as shown in Figure 2-14. 

 
Figure 2-14: Select automatic or manual activation 

2.8.1 Automatic Activation 

An active Internet connection is required for automatic activation. 

Note: If your company Internet security requires the use of a secure proxy server to 
connect to the Internet, then select the Requires Proxy Authentication 
checkbox and enter your user identification and password. 

Click Next to continue. 

Complete the required information fields as shown in Figure 2-15 and click Next. 

Note: The * denotes mandatory fields. 

 
Figure 2-15: Company details 
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The software now attempts to validate the license key. If successful, a message displays 

as shown in Figure 2-16. Click Next to continue. 

 
Figure 2-16: Automatic validation of the key successful 

Confirmation of successful license activation is shown in Figure 2-17. Click Finish to exit 

the Activation Wizard. To add a user, see Section 3.3.1. 

 
Figure 2-17: Automatic validation complete 
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If the key could not be validated due to a communication error (for example, if the 

Internet was down or the GE Digital Energy server was unobtainable) then a message 

displays as shown in Figure 2-18. 

 
Figure 2-18: Automatic validation failed 

To resolve, repeatedly click the Back button until the ‘Select Activation Method’ screen 

displays as shown in Figure 2-14 and instead select the Manual method. 

2.8.2 Manual Activation 

The manual method generates a unique ‘installation key’ that will need to be entered in 

the GE Digital Energy website along with your company details. The website will return a 

matching ‘activation key’ which should be pasted into the activation key field displayed 

on the license wizard. Follow these steps to manually activate Perception Server: 

In the Select Activation Method screen, select Manual and click Next as shown in Figure 

2-19. 
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Figure 2-19: Select Manual Activation 

The software’s unique installation key is displayed in the 6 boxes shown at the top of 

Figure 2-20. Click the Copy Installation Key link to copy the displayed installation key 

to the Windows clipboard. 

 
Figure 2-20: Obtaining Installation key 

Next use a web browser to visit the activation website: 

www.gedigitalenergy.com/perception/activation 

If there is a problem with the Internet connection, contact GE Digital Energy Support to 

obtain the activation key at: 

E-Mail: GA.support@ge.com 

North America toll-free: 1-800-361-3652 

Worldwide: 1-514-420-7460 

file:///C:/Users/502222358/Documents/DOCUMENTS/Perception/aaPerception%20Manuals%20118/www.gedigitalenergy.com/perception/activation
mailto:GA.support@ge.com
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On the Activation Key Request Form, click into the Installation Key field as shown in 

Figure 2-21 and right click to Paste the installation key into the entry field. 

 
Figure 2-21: GE Digital Energy activation website 

Complete the remaining details and click Activate. 

Note: All fields except ‘Area’ and ‘Position’ are mandatory. The web page will generate 
an error message if mandatory fields are not completed. 

If successful, an activation key is generated that is specific to this installation of 

Perception Server. An example is shown in Figure 2-22. 

 
Figure 2-22: Copy the key onto the clipboard 
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Copy the activation key from the web page and paste it into the Activation Wizard and 

click Next as shown in Figure 2-23. 

 
Figure 2-23: Manually paste the key from the activation web page 

The software validates the license key. If successful, a message displays as shown in 

Figure 2-24. Click Next to continue. 

 
Figure 2-24: Manual validation of the key successful 
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Confirmation of successful license activation is shown in Figure 2-25. Click Finish to exit 

the Activation Wizard. To add a user, see Section 3.3.1. 

 
Figure 2-25: Manual validation complete 

2.9 Establish Client Connections 

There are several prerequisite steps to perform before client\server communications are 

operative: 

▪ The client PC must have Perception Desktop installed. 

▪ A user must be created in the Perception Server Configuration Tool. 

▪ The user must attempt to open the connection with the Perception Server. 

▪ Both the client user and the server administrator then must override their respective 
trust certificates before the client-server link can work. 

▪ Every time a new client user is added, both the user and the server administrator 
must act together to override their trust certificates. 

2.9.1 Trust the Client Certificate 

The first time that a Perception Desktop client attempts to connect with the server, the 

connection is rejected as shown in Figure 2-26. This is because the client does not trust 

the server. To trust the server certificate, the certificate must be moved from the 

rejected certificate folder and added to the trusted certificate folder. 
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Figure 2-26: Server certificate not trusted 

Subsequently another connection error occurs as shown in Figure 2-27. This time 

because the server does not trust the client. To trust the client certificate, the certificate 

must be moved from the rejected certificate store and added to the trusted certificate 

store. 

 
Figure 2-27: Client certificate not trusted 

This will occur with every first connection attempt of a new user and so needs both the 

client user and server administrator to be logged in so that both can move the respective 

certificates to the trusted certificate store. To do this, follow these steps: 

In Windows 7/Server 2008, open Windows Explorer and navigate to the following 

location: 

C:\ProgramData\GE_Energy\Perception\RejectedCertificates 

Look for a certificate with this format: Perception.Desktop.<computer 

name>[key], where <computer name> is the computer name of the client and 

[key] is the public certificate key. 

Move the certificate from the rejected certificates folder to the trusted certificates folder 

at this location in Windows 7/Server 2008: 

C:\ProgramData\GE_Energy\Perception\TrustedCertificates\certs 

2.10 Firewall Settings 

In order that the client and server successfully communicate, Perception Desktop must 

be allowed to communicate through the firewall. A firewall program is usually accessed 

via the Windows Control Panel. In the advanced settings for Perception Server, ensure 

that ports 4840, 4841 & 62541 are open for inbound connection on the Perception 

Server machine. 

If the UA Discovery Server application is installed, it should be added as a program that 

can send and receive through the firewall. 
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2.11 Perception Database Upgrade Tool 

If migrating from a previous version of Perception or if you wish to import data from a 

legacy database, you must use the Perception Database Upgrade Tool to convert the 

database to a compatible format. The Perception Database Upgrade Tool can be used in 

several migration scenarios, such as converting: 

▪ an older local (KPD) database to a Perception 2.0 local (KPD) database 

▪ an older local (KPD) database to a Perception 2.0 SQL Server database 

▪ an older Perception SQL Server database to a Perception 2.0 SQL Server database 

The Perception Database Upgrade Tool can be found at the following location: 

C:\Program Files (x86)\GE Digital Energy\Perception 2.4.2 

Double click the Perception.Database.Upgrade.Tool.exe file to open the tool as 

shown in Figure 2-28. 

 
Figure 2-28: Perception Database Upgrade Tool 
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Use the tool to specify the source and destination database formats. 

Note: Depending on the type of upgrade, a path or database connection details may 
also be required. 

If moving from a local KPD database to a SQL Server database, use the tool to add 

appropriate user access. 

Finally, in the Database Server Location section, ensure that the tool is pointing to the 

newly updated database. 

Click Upgrade to start the upgrade process. 

Note: Customers should be aware that Perception does not support the ‘merging’ of 
databases. 

Note: If any issues occur during the migration of Server data, contact Customer 
Support. 
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3 CONFIGURATION 

3.1 Functionality Overview 

The Perception Server Configuration Tool allows complete configuration of the 

Perception Server. Once installed, the user interface presents seven tabs as shown in 

Figure 3-1. 

 
Figure 3-1: Perception Server Configuration Tool 

The seven tabs provide access to the different configuration themes of Perception Server 

as outlined below: 

▪ Alarm: See Section 3.4 Configure Alarm Emails. 

▪ Modem: See Section 3.5 Configure Modems. 
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▪ Database: See Section 2.5 Connect Perception Server to the database (performed 
during the initial installation). 

▪ User: See Section 3.3 Configure Users. 

▪ Activation: See Section 2.6 Activate the Perception Server. 

▪ TOA Export: See Section3.6 Export Download Data to TOA. 

▪ Map: See Section 3.7 Define Custom CSV Mappings. 

3.2 Menu Options 

The menu bar consists of two menus — File and Help. 

▪ File > Exit: Closes the Perception Server Configuration Tool. 

▪ Help > About: Displays an information dialog containing the Release notes, License 
agreement and Component version numbers. 

3.3 Configure Users 

By default, the Perception Server allows anonymous connections from Perception 

Desktop. This is less secure as access is not restricted to requiring valid login credentials. 

It is recommended that all users are configured on the Perception Server to provide an 

audit trail of all user actions. See Appendix A for details on how to remove anonymous 

users. To configure users on the Perception Server, open the Perception Server 

Configuration Tool and select the User tab as shown in Figure 3-2. 

As a security precaution, the user session in Perception Desktop can be controlled from 

Perception Server to automatically close in the case of a period of inactivity. The User 

Session Settings define the Inactivity timeout in minutes, where 5 minutes is the default. 

To turn off the inactivity timeout period, change this value to 0 to ensure that the session 

stays open. 
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Figure 3-2: Configure users 

In the example above, Ed is of ‘Architect’ status (full read-write with workflow 

permissions), Jim is of ‘Observer’ status (read-only permissions) and Robert is of 

‘Supervisor’ status (full read-write permissions). 

By default, users are authenticated internally against the list of Perception Users as 

shown, for example, in Figure 3-2, but alternatively can be authenticated using the 

operating system’s Active Directory. To enable Active Directory, select the Active 

Directory checkbox and type the predefined network group names in the respective 

text fields to map the Active Directory users to Perception roles. For example, if the user 

is in the network Architect User Group, then it will resolve as a user of the ‘Architect’ role 

in Perception. 

If Active Directory is enabled, Perception will first attempt to authentic users using 

Active Directory and if not found, then attempts authentication against the internal list 

of Perception Users. 
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Note: The Import permission is an additional right that can be assigned to any role. 
Inadvertently importing the wrong data could overwrite valid data, so this right 
should be assigned with caution. 

3.3.1 Add a user 

To add a new user, click the Add button. The Add User dialog displays as shown in 

Figure 3-3. 

 
Figure 3-3: Add user dialog 

Specify a username and password. Assign a role according to the required permissions 

outlined in Table 3-1. If the user requires Import Permission, select the Import 

Permission checkbox. Click OK to add the new configured user. 

Table 3-1: Role permissions 

Role Permission 

Supervisor Full read / write access 

Observer Read Access only 

Architect Full read / write access with workflow 

The new user is added to the list of users as shown in Figure 3-4. 
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Figure 3-4: List of users 

3.3.2 Edit a user 

To edit a user, open the Perception Server Configuration Tool and select the User tab as 

shown in Figure 3-4. Select a user and click the Edit button. The Edit User dialogue is 

displayed as shown in Figure 3-5. 
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Figure 3-5: Edit user details 

It is possible to change all details except the Username. Click OK to confirm the change. 

3.3.3 Delete a user 

To delete a user, open the Perception Server Configuration Tool and select the User tab 

as shown in Figure 3-4. Select a user and click the Delete button. 

 
Figure 3-6: Delete a user 

A confirmation message appears. Click Yes to delete the user. 
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3.4 Configure Alarm Emails 

Emails can be issued to alert users of device condition or communication issues. To 

configure the server to issue emails, open the Perception Server Configuration Tool and 

select the Alarm tab as shown in Figure 3-7. 

Note: To receive such emails, Perception Desktop must be configured with an email 
address in the Notification E-mail Address box via the device’s Properties tab. 
See Section 3.8.4 Device Properties in the Perception Desktop Installation & 
User Guide. 

 
Figure 3-7: Alarm email configuration 

The following details need to be completed: 

Login Information: Enter the authentication details to allow access to the SMTP server. 

Note: Consult with your IT Administrator to see if authentication is required. 

Server Information:  
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In the Outgoing mail server (SMTP) box, enter the SMTP server address. 

In the Port box, enter the email port — typically 25. 

In the Enable SSL\TLS (explicit) checkbox, select the checkbox to enable this feature. 

This provides support for an encryption protocol to secure SMTP connections over ports 

25/587. 

In the E-mail Address box, enter the email address of the sender of the emails E.g. 

‘noreply@yourcompany.com’. Note: The email address does not have to exist. 

In the Expert E-mail checkbox, select the checkbox to enable this feature. See Section 

3.4.1 below. 

In the Maximum communication failure count box, specify the number of failures 

required before an email is sent. This is designed to limit the number of emails recipients 

receive about a communication issue. 

Wallboard pulsing: 

In the Enable pulse for all nodes checkbox, select the checkbox to enable the dynamic 

animations such as pulsing or rippling on all assets on the Perception Desktop wallboard 

(when an alarm is triggered or a risk index changes). The default is Off. 

3.4.1 Expert analysis emails 

A further email can be issued to nominated persons containing more detailed 

information on the alarm. 

To enable this feature, select the Expert E-mail checkbox in the Perception Server 

Configuration Tool. 

In the Expert E-mail history record count, specify the number of records to be 

included as a CSV attachment in the email. The default is 20. 

Note: To receive such emails, Perception Desktop must be configured with an email 
address in the Expert E-mail Address box via the device’s Properties tab. See 
the Perception Desktop Installation & User Guide for ‘Setting up Asset 
Properties > Device Properties > Email’. 

3.5 Configure Modems 

To configure the modems used by Perception Server, open the Perception Server 

Configuration Tool and select the Modem tab as shown in Figure 3-8. 

All available modems to the Perception server are listed. Select the checkbox next to 

each modem you want the Perception Server to use. 

When Perception Server attempts a data download, the Server will use the first available 

modem in the list. If that modem is busy, the server will try the next selected modem on 

the list until an available modem is found. 

Note: Ensure that selected modems are exclusive to Perception Server and not used 
by any other applications running on the Perception Server host. 
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Figure 3-8: Modem configuration 

3.6 Export Download Data to TOA 

If interrogation and analysis is required using other tools, the Server can be configured to 

export all downloaded data to the universal TOA format. 

Select the Export tab and select the Export download data to TOA files checkbox as 

shown in Figure 3-9. 

 
Figure 3-9: TOA Export 

The files are stored at the following location: 

C:\ProgramData\GE_Energy\Perception\Export\TOA 
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The files are named as follows: 

<device serial number>_YYYYMMDD_Time.TOA 

Where YYMMDD is the date in reverse order so that it is listed in the correct chronological 

order in Windows Explorer. 
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3.7 Define Custom CSV Mappings 

The Map page allows you to define custom CSV mappings for imports and exports. Click 

the Import tab to specify the source and destination field names to ensure correlation 

of the imported data. 

 
Figure 3-10: Import Mappings 

Note: The import map now includes alarms and engineering units. 

Click the Export tab to customise the export in a similar way. 

 
Figure 3-11: Export Mappings 
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If the export table is empty, click Add to add the default fields serialnum, 

sampledate and asssettype to the table as shown in Figure 3-12. Additionally, you 

can select a date and time format and reorder the rows accordingly. 

 
Figure 3-12: Custom CSV mappings 
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Appendix A Removing anonymous user permissions 

Anonymous user access is enabled by default. This means users do not have to supply a username 

or password to login to the server, but are limited to Observer (read-only) status. However, for 

security reasons it may be prudent to remove anonymous user access. 

The user token permissions are in the “perception.server.config.xm” file which can be 

found in the following folder on Windows 7 or Server 2008: 

C:\ProgramData\GE_Energy\Perception 

The anonymous user token policy code is as below: 

-<UserTokenPolicies 

xmlns:d2p1="http://opcfoundation.org/UA/2008/02/Types.xsd"> 

-<d2p1:UserTokenPolicy>  

<d2p1:PolicyId 

xmlns:i="http://www.w3.org/2001/XMLSchema-instance" 

i:nil="true"/> 

 <d2p1:TokenType>Anonymous_0</d2p1:TokenType>  

<d2p1:IssuedTokenType 

xmlns:i="http://www.w3.org/2001/XMLSchema-instance" 

i:nil="true"/> 

 <d2p1:IssuerEndpointUrl 

xmlns:i="http://www.w3.org/2001/XMLSchema-instance" 

i:nil="true"/> 

 <d2p1:SecurityPolicyUri 

xmlns:i="http://www.w3.org/2001/XMLSchema-instance" 

i:nil="true"/> 

 </d2p1:UserTokenPolicy> 

The d2p1 section is repeated for ‘Observer’ and ‘Supervisor’ tokens. You can delete all between, 

and including the lines d2p1.... to /d2p1... or comment it out by changing 

<d2p1:UserTokenPolicy> to <!--d2p1:UserTokenPolicy> and 

</d2p1:UserTokenPolicy> to </d2p1:UserTokenPolicy>--> 
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Appendix B Communicating with Perception Server via OPC UA 

Perception Server utilizes OPC UA to establish secure client\server communications to and from 

Perception Desktop. 

OPC UA also provides a standardised secure communication protocol that third party applications 

can use to communicate directly with the Perception Server. This allows other products to read, 

write and poll information from Perception Server. 

Refer to the online OPC foundation documentation for technical information on communicating 

using OPC UA. Visit https://opcfoundation.org/. 

https://opcfoundation.org/
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Appendix C Troubleshooting 

C.1 Tabs not enabled on the Perception Server Configuration Tool 

For the Perception Server and Perception Server Configuration Tool to run in the 

Windows 7 environment with multiple users, the SQL Server/ SQL Express login must be 

given “sysadmin” rights. The following steps outline the process to make the necessary 

changes in the database security settings: 

 Launch Microsoft SQL Server Management Studio application. 

 Expand the Security node as shown in Figure C-1. 

 To create the required login, right click on the Logins node and select New Login. 

 
Figure C-1: SQL Server Management Studio Express Tool 

The Login - New dialog appears as shown in Figure C-2. Select the General node and 

then click the Search button. 

 
Figure C-2: Login > New Dialog 
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The ‘Select User or Group’ dialog appears as shown in Figure C-3. Click the Advanced 

button to expand the dialog as shown in Figure C-3. 

 
Figure C-3: Select User or Group dialog 

Click the Find Now button as shown in Figure C-4 to list all the Users and User Groups in 

the lower section of the window. 

 
Figure C-4: Select User or Group dialog – expanded 
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Select Authenticated Users as shown in Figure C-5 and click OK to continue. 

 
Figure C-5: List of users and groups 

In the ‘Login – New’ dialog, select the Server > Roles node, then select the sysadmin 

checkbox and finally click OK to complete the process as shown in Figure C-6. 

 
Figure C-6: Sysadmin server role assigned 

The SQL Server/ SQL Express login now has the required ‘sysadmin’ rights. 
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C.2 General Faults 

Table C-1 lists several problems and resolutions. 

Table C-1: Problems & Resolutions 

Problem Resolution 

Perception Server service 
starts and then stops 
within a few seconds. 

This happens if the Perception Server service is started 
without first using the license key to activate the software. 
See Section 2.6 to activate the software. 

Perception Server will fail to start if FILESTREAM is not 
enabled for the Microsoft SQL Server instance. 

If using Microsoft SQL Server 2012, this can happen if the 
NT Authority\System account does not have ‘sysadmin‘ 
privileges. 

Users are no longer able to 
log in even though 
usernames and passwords 
are correct 

This can occur if a new server certificate has been created 
on the Perception Server host. For example, if Perception 
Server has been migrated to another machine. To resolve, 
delete and recreate the users. 

Perception Service does 
not appear in Desktop 
Discovery wizard. 

This can be caused by several incorrect configurations. 

▪ Ensure that the IP Address or Hostname of the 
Perception Server is correct. 

▪ For Perception version 1.18 or greater, ensure that the 
UA Local Discovery Server service is stopped. Verify in 
services.msc. 

▪ Ensure that the Perception Server Service is running. 
Verify in services.msc. 

▪ Ensure that the SQL Service is running. Verify in 
services.msc. 

▪ Ensure that the Kelman database is configured in the 
Perception Server Config Tool. 

▪ Ensure MS-DTC is configured correctly: 

▪ For Windows Server 2008, see 
http://support.microsoft.com/kb/817064 

▪ Ensure that the Perception Server and Discovery Server 
certificates exist in the trusted certificate folder and are 
configured correctly within the services configuration 
files. To correct the configuration, run the Perception 
Server installer and select the repair option. 

Database Upgrade Tool – 
upgrade fails from KPD to 
SQL Server when data from 
one of the assets already 
exists on the Server 

First export the data from a KPD database to a CSV file. 
Use the Database Upgrade Tool to convert to the new 
database. Import the data into the new database. 

Perception Server 
Configuration Tool tabs not 
enabled 

When using the Perception Server Configuration Tool 
across multiple users on the same Microsoft Windows PC 
the ‘Authenticated Users’ in Microsoft SQL must have 
‘sysadmin’ profligates 

Perception Server 
installation fails error – 
‘Console Error’. 

Intermittent error - Perception Server installer fails to 
complete and gives a ‘console error’, when installing on a 
PC which has already had Perception Desktop or Server 
installed previously. 

 

To resolve this issue: 

http://support.microsoft.com/kb/817064
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 Browse to C:\ProgramData\ 

 Delete the 'OPC Foundation' folder 

 Browse to C:\Program Files (x86)\Common Files (on 

x64 OS) 

 Delete the 'OPC Foundation' folder 

 Browse to C:\Program Files\Common Files (on x86 OS) 

 Delete the 'OPC Foundation' folder 

 Uninstall Perception Desktop & Server 

 Re-install Perception Server 

 Re-install Perception Desktop 

Unable to restore Kelman 
database in SQL Server 

This occurs if FILESTREAM is not enabled for the Microsoft 
SQL Server instance. 
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Appendix D NERC-CIP Compliance 

The following events are recorded in an audit log to assist organizations with NERC-CIP 

compliance: 

▪ Adding nodes. 

▪ Deleting nodes. 

▪ Add/delete references (drag-and-drop nodes). 

▪ Import events. 

▪ Export events. 

▪ Import export mapping changes (add, update and delete events). 

▪ Server start stop events. 

▪ Workflow configuration in transformer properties (adding, updating and removing). 

▪ Uploading workflow events on the server and deleting workflow events. 

▪ Uploading wallboards. 

▪ Save the wallboard configuration event, such as when moving a node position on the 
wallboard. 

▪ Write events for the configuration changes. 

▪ Device setup event when launching setup. 

▪ Login, logout events. 

▪ Perception Server Configuration Tool changes. 

Audit data is recorded in the following files: 

▪ Audit-Server.log — contains audit data maintained by Perception Server. 

▪ Audit-ServerConfiguration.log — contains audit data on the Perception Server 
Configuration Tool. 

The log files can be found at this location: 

C:\ProgramData\GE_Energy\Perception\Logs 
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